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Disclaimer:  Names in this document are entirely fictional.

They bear no resemblance to anyone living or dead.



V1.3

About TIMS MVP “Auto Save” & “Non-Destructive Editing”

TIMS MVP auto-saves all recording & edits.

There is no save command or button.

TIMS MVP uses non-destructive editing.

Deleted and trimmed imagery can be

restored before sending to a new destination.
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Workflow Options
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Workflow Options: Send to PACS Only

Several common workflows are used by our customers. The next few slides will explain the pros and cons of each.

The most basic workflow is to record with TIMS MVP in the fluoro room, 

then send the completed study directly to PACS.

PROS

• Radiologists can quickly access the study if it needs to be “read” 

immediately after it was performed.

CONS

• Any edits (trimming or deleting series) to the study will need to be 

performed in the fluoro suite, possibly tying up the room.

• Further review of the study will have to be performed using PACS client 

software which is often not optimal for high resolution / high frame rate 

imagery.

PACS

Top
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Workflow Options: Send to TIMS Review, then PACS

The most common workflow used by our customers is to record with 

TIMS MVP then send the completed study to a TIMS Review 

workstation (usually in the Speech Office). The study can be

 edited / reviewed more thoroughly and finally archived to PACS.

PACS

TIMS Review Workstation

PROS

• Reduce time spent in procedure room. Review & editing done 

elsewhere.

• The study can be significantly reduced in size through trimming and 

deleting unwanted series.

• The TIMS Review software is optimized for smoothly reviewing high 

resolution / high frame rate imagery.

• TIMS Review includes tools for clinically analyzing MBSS such as 

scoring, timing swallowing events, frame-by-frame playback, etc.

• TIMS Review is an ideal platform for consulting with patients & their 

families.

CONS

• Study not available in PACS until sent from TIMS Review.

Top
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PACS

TIMS Review Workstation

A compromise is to record with TIMS MVP then send to both 

PACS and TIMS Review simultaneously.

PROS

• Study immediately available in PACS for radiologist to review.

• All of the benefits outlined in previous slide for using TIMS 

Review to review and analyze study.

Workflow Options: Send to PACS & TIMS Review Simultaneously

Top
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Connecting and 

Powering on TIMS MVP

Top
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TIMS MVP typically has 4 connections: Video, Trigger, LAN (network) and Power.

Find the corresponding cables coming from the TIMS mobile cart and make the connections.

The cables are usually labeled.

Trigger (will match one of these connections)

TIMS MVP Mobile Cart Connections

Top

Depending on which  

TIMS System you 

have, the capture 

board will look like 

one of these.
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Powering on TIMS MVP

Find and press the power button on the front panel of the 

TIMS MVP computer.

Top
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Recording a Study

Top



To launch the TIMS MVP application:
- Double click the icon on the desktop or
- Single click the icon on the task bar

Top
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TIMS MVP should open directly to the Worklist tab in the Study Dashboard.

The Study Dashboard is the starting point for creating a new study, or 

opening an existing study from the Studies tab.

* If you aren’t using a Worklist, you can enter patient information manually 

using the “New Blank Study…” button.

Top
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TIMS MVP should open directly to the Worklist tab in the Study Dashboard.

The Study Dashboard is the starting point for creating a new study, or 

opening an existing study from the Studies tab.

* If you aren’t using a Worklist, you can enter patient information manually 

using the “New Blank Study…” button.

You can quickly search on any 

column using the “filter list” option.

Top
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The filtering option is very powerful. You can 

search on virtually any column by typing just a few 

letters. Here the list has been narrowed by typing a 

few letters of the patient’s first name.

Top
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The list has been further narrowed by adding a space then 

a few letters of the referring doctor’s last name.

Top
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You may also filter by study date if you need to locate a patient 

from a previous or future date by clicking on the calendar icon.

Top
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You may also refresh the worklist by clicking this icon.

Top
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Select your patient from the worklist.

Double click, press “Enter” on the keyboard, or 

click the “New…” button to proceed.

Top
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The “Study Info” screen provides you with the opportunity to 

confirm that all the study information is correct or make any 

necessary changes. These fields are all editable if required.

Top
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If your TIMS MVP System is on a mobile cart, and 

used in more than one procedure room, be sure 

the correct modality or room designation is 

selected in the “Channel” setting. The “Keywords” field is for your reference only. This 

information is not sent to PACS. It is a handy way to 

quickly find completed studies later in the Study 

Dashboard. Once you enter a keyword, it will 

autocomplete the next time you start typing it.

Once everything looks complete, click “OK” to proceed.

Top
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TIMS MVP is now ready to start recording.

But let’s first look at some of the information and 

options available in the LIVE tab.

Top

TIMS MVP will next open into the “LIVE” tab. Click here anytime 

during a study to see the live video from the fluoroscope.

TIMS MVP is now ready to start recording.

But let’s first look at some of the information and 

options available in the LIVE tab.
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TIMS MVP typically starts and stops recording 

automatically along with the fluoroscope. However, this 

start / stop record button, or the spacebar on the 

keyboard, allow you to manually start & stop recording.

Elapsed recording time.

The camera button takes a 

single frame “snapshot” of 

the current image. Or press 

the F12 key.

Mute / Unmute audio 

recording 

Turn on / off audible tone that 

signals recording start / stop.

Recording frame rate.

Open and close the panel for 

viewing Tools and 

Telestrations

Open and close the panel for 

thumbnail views for each 

recorded series and maximize the 

viewing space for the Live video

Open / Close the 

PatientView window.

Top
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The study is automatically captured with the 

Fluoro pedal!

All the red indicators help to show when the 

recording is in the process of capturing .
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Top

TIMS MVP automatically saves the study as you record it. 

There is no “save” button. 
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There are several ways to zoom in and out on the live image:

•Click “+” or “-” on the magnifying glasses.

•Double click on your area of interest to zoom in by 2x. Double click 

again to zoom back out.

•Hold down the Ctrl key and type “+” or “-” to zoom in and out

 multiple levels. Use the scroll bars to reposition the image.

Top
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Labeling During the Study 

& Protocol Mode

Top
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TIMS MVP allows to you to quickly apply labels to each 

swallow to identify the consistency given to the patient. 

Start by selecting a label set. Several sets come with 

TIMS MVP, including “Defaults” and “MBSImP”.

Top
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Once you have a label set selected, there are several ways to label during the study:

1) Click in the field shown and scroll down to select the correct label.

2) Start typing characters from any word in the label. TIMS MVP will start matching from the list.

3) Enable Protocol Mode, the fastest and most convenient method, covered next…

Top
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Protocol Mode allows you to efficiently label the study as you are 

recording, reducing time spent in the fluoro room. If you typically follow 

a protocol for administering the same sequence of consistencies, 

Protocol Mode would be a good choice.

After you have selected your 

desired label set, click the 

Protocol Mode button to enable it. 

Top
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While enabled, you can advance forward and backward through your label set 

using either the on-screen arrows or the left & right arrows on your keyboard.

Before recording each swallow, advance to the next label. 

The Protocol Mode button turns 

green, indicating it is active.

Top
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The labels will be automatically applied as you record each 

series, and visible at the top of the thumbnails on the left.

Top
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If at any time you need to modify a label, or enter one not on your list, just disable 

Protocol Mode temporarily, enter your label, and turn Protocol Mode back on.

Top
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Quickly Reviewing 

Recorded Swallows

Top
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To start a review, single click on a thumbnail to view it in the Series Tab…

Recordings start in the live tab and give you a real time view of the action, 

but you can review “on-the-fly” if needed.
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The green line indicates that you are now in the SERIES tab.

Select the LIVE tab at any time to return to the live video stream. 

• “Scrub” through the recorded video by holding down the left mouse button and 

moving up & down or right & left

• Or scrub using the “play head” control.

• Use the mouse wheel or the arrow keys for frame-by-frame precision.

Top
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Review the series using the Play / Pause button.

Or use the space bar to start and stop the playback.
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Return to the live view by clicking the LIVE tab.

Top
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Sending a Study to 

PACS or TIMS Review

Top
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Click the SEND button to send the study.

When you have completed the study, it can be sent to one 

or more destinations. Typically, studies are sent to PACS 

or VNA for long-term archival. They can also be sent to a 

TIMS Review workstation for editing and analysis.

*Once you decide to send the study it will be locked 

from further editing or recording. 

The study can be manually unlocked later if necessary.

Top
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TIMS MVP will highlight any missing 

information in red. The information can be 

added before sending, but it will still send to 

PACS fine without it.

The possible send destinations are 

listed here. Check any that you wish 

to send to. TIMS MVP will remember 

your selections for next time.

Top
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If “Send Checked” is selected, you can 

optionally choose just specific views to send.

TIMS MVP displays the series count, total 

study size in megabytes, and total number of 

images that will be sent.

Click SEND to begin sending.

Top
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After sending the study you can close it, 

unless you wish to review it further.

TIMS MVP will then return you to the Study 

Dashboard to prepare for your next patient! 

Top
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To monitor the send status of a study, first switch to 

the STUDIES list by clicking on its tab.

The 3 green dots in the Send Status column 

means the send is in progress.
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You do not need to wait for a study to be sent before starting 

another study. TIMS MVP can do both at the same time!

When the study has been successfully sent, the dots will change to a green 

“up” arrow. TIMS MVP can now be powered off.

 It’s important to not power down the computer before the indicator is verified. 

Top
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If the Send Status is a red up arrow, the study was not 

successfully sent to ANY destination.

If the Send Status is a yellow up arrow, the study failed 

to send to at least one of your send destinations.

If there was an error sending to a destination, more 

specific information is available. We’ll cover that next…

Top
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“Right click” on a study and select “Send Status…” to  

get detailed send status information.
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In this example the study was successfully sent to “Main PACS” but failed to 

send to “TIMS Review 1”. The primary error is listed at the bottom. This 

information is useful to someone troubleshooting a potential problem.
 Before performing additional send attempts, it is recommended to clear errors first. 

Top
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Editing a Study

Top
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There are several ways to access the Study Dashboard if it is not already open:

• Click the “OPEN” button

• Choose “Open…” from the File menu

• Type “Ctrl+O” on the keyboard

Top
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Select your patient from the STUDIES list.

Then either “double click”, press “Enter” on the 

keyboard, or click the “OPEN…” button.

As with the Worklist, you can use the “Filter List” 

option to quickly find your patient.

Top
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Once it has opened, click the green padlock to unlock it for editing.

Top
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If you need to record more imagery to this study, you will also need 

to unlock the LIVE tab. This is not typical though.

The study is now ready for editing.

Top
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When you open a study, you will be in the STUDY tab, which is indicated by the green underline.

The STUDY tab provides a good overview of all the series in your study. You can also:

• Scrub through each series to play the video

• Zoom into an area of interest

• Invert images

• Make Contrast & Brightness adjustments

• Label each series

• Delete unwanted series

• Combine multiple nearby series into one

• Split a series into two series

• Flag one or more series to be sent to another destination

• Modify Study Info if something needs to be changed

Top
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The SERIES tab allows you to perform all the same editing functions as the STUDY tab, but 

also provides tools for in-depth review:

• Frame-by-Frame analysis

• Fast & Slow-Motion playback

• Comparing of two series side-by-side can be done for deeper analysis

• Trimming to remove unneeded images from either side of a series

• Create a Subclip 

• Create a Composite Clip to combine multiple individual series into one

• Extract a Single Snap image 

• Timing of swallowing events

• Annotations can be added to visually highlight important details in an image

• Measurements can be taken and added to a report

• Scoring can be documented and added to a report

These tools are covered in detail in the section on “Reviewing a Study”. For now, let’s look at 

the options available back in the Study Tab.

Top
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This indicator tells you exactly which 

image number (out of the entire study) 

you are currently viewing, and which 

series contains it.

To make the images larger or 

smaller, use the Zoom controls.

The Invert, Contrast, & 

Brightness controls adjust all the 

images at once. These do not 

modify the saved image data, just 

how you are viewing them now.

We will cover the Flag and Delete 

controls later in this section.

Just like in the SERIES tab, you can “scrub” through the 

video in each series by holding down the left mouse 

button and moving up & down or right & left.

Tap the space bar to start / stop playback as well.

Here you can sort all the Series by 

Time, Type, Size, or Label.
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If you are labeling the study after it has been recorded, the 

fastest way is here in the STUDY tab. First select the label 

set you’d like to use. Creating and editing these label sets 

is covered in another section.

Top
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Click in the label field the label choices appear below. You can simply scroll through 

the list and select the correct label.

Another quick option:

• Start typing any part of the label you want to apply

• Use the “down arrow” key on your keyboard to highlight the correct label

• The “tab” key will then accept your selection and move you on to the next series

Top
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You can also label while in the SERIES tab. You’ll see a larger 

image and hear the recorded audio when you play the video.

The onscreen arrows will move you from one series to the next. 

Or use the UP / DOWN arrows on your keyboard!

Top
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Note that TIMS MVP does not actually delete the underlying 

image data, so it can be retrieved later if you wish!

To delete a series you don’t want to send to PACS, simply “right click” on the series 

and a menu will appear. Choose “Delete” and it will be removed. You can also use 

the Delete icon at the bottom of the screen to delete any currently selected series.

Top
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If you want to view all the series you have “deleted”, just “right click” once 

again and choose “Show Deleted” from the menu. The series that are marked 

as deleted will now display a red underline.

Top
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If you want to undelete a series, just “right click” on that series and uncheck 

“Delete” from the menu or click the Delete icon at the bottom of the screen.

Top
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Top

That example is shown here with two series that are 

from the same swallow. To combine the two, “right 

click” on the first series and choose “Combine with 

Next”. The two series will be merged.

There may be occasions when you want to combine two series into one. For example, if 

the radiologist lets off the foot pedal in the middle of a swallow and immediately starts 

back up again you will end up with two series for the same swallow.

Top
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Top

Under the Series Tab you can create a Composite Clip for occasions 

when you want to combine any two or more series.  

Top
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Top

Select the individual series you want to 

combine with the arrows.

Top
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Top

Drag the Triple Bar to rearrange the order 

for the Composite Clip.

Top
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Top

Select OK to combine those 

individual series. 

You can create the Label you want for the new Composite Clip 

and it with automatically label it for you. 

Top
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Top

The new clip is added the end of the study. It will be marked with 

the Composite Clip icon and marked with a label if one was added. 

The other original series remain intact.
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Top

Another option is to replace the smaller individual series with the newly 

created Composite Clip. To do this select “Replace Included Series”.

Top
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Top

Here the new clip is replacing the original series runs. It is placed in the 

temporal order in which the first series was recorded. It will be marked with 

the Composite Clip icon, and it will include any label that was created for it. 

Top
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Conversely there may be times when you want 

to split one series into two or more series.

In this case, scrub through the series until you 

get to the point at which you want to split. 

“Right click” and choose “Split”. A new series 

will be created immediately after it with the 

same label if one has been applied.

Top
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Splitting and combining series can also be done in the Series Tab where you 

can use the keyboard left and right arrow keys for frame-by-frame precision.

To combine the current series with the next one “right 

click” and select “Combine with Next” (or Ctrl+U).

To split the current series scrub then move frame-by-

frame to the exact frame where you want to split. 

Then “right click” and select “Split” (or Ctrl+T).

Top



V1.3

Here is the result of the split series broken into two smaller individual series with 

the same label. The icon indicates that the clip size has been changed.

Top
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TIMS MVP makes it easy to trim a series down to just the content you 

want to keep. Perhaps there are several seconds of chewing at the 

beginning of the series you don’t need. Or the radiologist was slow to 

come off the foot pedal and there’s extra video at the end.

Some hospitals limit how big the swallow studies can be to send to PACS. 

Trimming the series can dramatically reduce the size of the overall study.

By “double clicking” on a series you will move to the SERIES tab, which 

has the tools for trimming.

Top
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Note that we are now in the SERIES tab, which 

is indicated with the green line under it.

The SERIES tab zooms in on one series at a time, with the 

rest of the study displayed on the left. The series we are 

working on is indicated with the green box around it.

First, we’ll learn how to trim using the markers below. 

Sliding them left and right will mark new start and end 

points for this series.
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As you drag the left marker to the right, the video will scrub 

along with you. In this case the marker has been positioned at 

the point where the patient is just about to swallow.
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Here the right marker has been dragged left to the point where the patient has 

just swallowed the bolus.

This is a good example of how trimming can significantly reduce the overall 

size of the study. This series is now a fraction of its original length.
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To trim the next series either select it on the left or 

use the down arrow on the keyboard to advance. 

Notice the icon that shows the series has been 

trimmed and indicates the new frame count.

Top
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Top

At any time, if you want to reset the trim points and revert to the 

original recording, click the “x”.

Just like deleting, the changes you make are not permanent, so 

you don’t need to be afraid of losing any data.
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Top

Type “[“ for start point. Type “]“ for end point.

Another very efficient way to trim is to scrub with your 

mouse right on the image. Use the “[“ key to mark the start 

point. Scrub some more and use “]” to mark the end point. 

Then use the on-screen arrow to move to the next series.
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Top

An alternate way to break up a series is to create smaller Subclips. 

to review this method, click here.



V1.3

Annotations can be added to an image and a “snapshot” created so that it 

may be sent to PACS along with the study for easy reference by colleagues.

Start by clicking the Annotation icon to reveal the annotation tools. 

Top



V1.3

Chose the color and thickness that you 

want for your annotations. 

Top
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The Pointer tool at the top can be used when reviewing studies in 

real-time with patients or colleagues.

The Arrow tool is for highlighting important details in the imagery.

The Line tool allows for drawing straight lines.

The Circle tool allows for circling details in the imagery.

The Magic Brush and the Magic Wand are used to determine area 

and will be discussed in detail in the “Measurement” section.

The Freehand tool allows for free hand drawing.
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Use Ctrl-Shift and drag to extend a line when using the Freehand tool. 
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Toggle the ruler icon to add text to an annotation. 
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Without taking a “snapshot”, annotations will be displayed only as overlays on the images.

Individual lines and drawings can be removed completely with the Delete tool 

or removed one-by-one with the Undo tool. 

Erase individual annotations by hovering over an item with the 

Eraser tool or move them using the Move tool.

Top
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There are several ways to take a “snapshot” of your annotation:

• Click the Camera icon on the toolbar 

• Select  “Create Image Snapshot” from the Series menu 

• Press F12 on the keyboard

A single image will be saved to the end of the study with your annotations.

Top
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This single snap image can be sent with the study to PACS or any destination. By 

default, TIMS adds the frame number and lists the series number from where the 

image was extracted .Click the “x” to change this information and gain access the 

label sets or type in the line field to add more information as needed. 
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The single snap image will replace 

the original. Note the Camera icon at the 

bottom left of the new image. 
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If you intend to send only some of the study’s series to 

PACS or another destination, you can “Flag” those series so 

they are already selected when you initiate the send. This 

can be done from either the STUDY or SERIES tab.

Top

There are several ways to flag a series:

• ”Right click” on the series and choose “Flag” from the menu

• Keyboard shortcut “Ctrl+F”

• Click the “Flag” icon when in the STUDY tab
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Top

When you are ready to send your 

study, you’ll see that “Send Checked” 

is already active, and all the flagged 

series are marked for sending.
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Top

If you need to modify any of the Study 

Info fields, you can do so by first 

clicking the “INFO” button.

Then make any necessary changes 

and click “OK”.
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Reviewing a Study

TopTop
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Top

There are several ways to access the Study Dashboard if it is not already open:

• Click the “OPEN” button

• Choose “Open…” from the File menu

• Type “Ctrl+O” on the keyboard
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Select your study from the STUDIES list.

Then you can either “double click”, press “Enter” 

on the keyboard, or click the “OPEN…” button.

As with the Worklist, you can use the filtering 

option to quickly find your patient.

Top



V1.3

Top

If you will not be editing the study, it can remain locked while reviewing 

to prevent making changes accidentally.

If you do wish to make edits, click the green padlock to unlock it. 
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The SERIES tab provides a variety of tools designed to help 

you efficiently analyze your swallow studies.

In this section you’ll learn how to:

• Review frame-by-frame

• Play slow motion

• Zoom on an area of interest

• Time swallowing events

• Create a study summary for your report

Top
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Start by clicking on the SERIES tab.

Top

You can review any series in the study by clicking on 

its thumbnail. The down and up arrows on the 

keyboard will also navigate you through the study.
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There are several ways to review the video.

Click anywhere in the video and drag the mouse 

up & down or left & right to “scrub” through it.

Top
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Top

Or use the Play / Pause button.

The spacebar on the keyboard 

does the same thing.

Click anywhere along the green timeline and the 

“play head” will jump to that location. Then drag it 

left & right to scrub through the video. You may also 

use the mouse wheel to scroll or use the arrow keys 

on the keyboard for frame-by-frame precision.
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Top

You can choose a playback rate from ¼ speed to 2x speed.

You can also play in reverse motion.

• “Play All” will play back the entire study.

• “Loop” plays the same series over and over.

• The Play All or the Loop options can be combined with a playback rate.This indicates the frame rate at 

which the study was recorded.
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Top

TIMS MVP can display any of the following information next to the timeline:

• Image Number: The current frame number in this series.

• Image Time: A time stamp, from the beginning of the study, to the current image. If you have deleted or 

trimmed any series, they are not included in this calculation.

• Recorded Time: Displays the total recorded time.

• Elapsed Time: Total elapsed time starting from when the first frame of the study is recorded. This timer 

runs whether you are recording or not, so you can determine how long the study ran start to finish.
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The magnifying glasses zoom the image in and out. When zoomed in you 

can either “grab” the image with your mouse and drag to reposition or use 

the scroll bars that will appear on right and bottom of the image. You can 

drag the image while it is playing, to follow the bolus for example.

Top
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Top

Contrast and Brightness controls. They only effect how you 

are viewing the image and do not change the saved imagery.

The icon changes to green if it is in use. Single click on it 

again to revert back to the original setting.
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Top

The Invert button inverts the brightness values of the image.
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Top

To time a swallowing event, first scrub to the first 

frame of event you’d like to time. Then click the 

Stopwatch icon and a timer will appear.
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Then scrub, either by dragging the play head or scrubbing on 

the image, to the end of the swallowing event. The total time 

will be displayed down to the 1000th of a second.

Alternatively, you can time an event by “right clicking” (either on 

the green timeline or on the image) and scrubbing. The timer 

will automatically turn on and time the event.
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Top

The “copy image” function is also available by using 

“right click” with your mouse. When copying an 

image, you have the option to use an “Area of 

Interest” to crop out patient information if needed.  

To copy and paste a specific frame into another program, just scrub to it 

and choose “Copy Image” from the Edit menu.

Paste as you normally would into any application that supports images.
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To create a “mini report” which includes information on all the series 

in the study select “Copy Study Info” from the Edit menu.
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Key fields from the Study Info, along with a summary of all the series and any labels you’ve 

applied can then be pasted into most other applications.

Top
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Exporting Studies

Top
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Studies can be exported either in DICOM format, or as a 

backup in the native TIMS MVP format.

To initiate an Export from a study that is already open, choose 

“Export…” from the File menu.

Top
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The Export Setup dialog box will appear. 

The top left “Export” option allows you to 

choose between Backup or DICOM.

Top
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Top

Contrast and Brightness controls. They only effect how you 

are viewing the image and do not change the saved imagery.

The icon changes to green if it is in use. Single click on it 

again to revert back to the original setting.
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DICOM is used by the healthcare industry 

and allows imagery and its associated study 

information (patient name, DOB, etc.) to be 

easily exchanged throughout the hospital’s 

information systems (PACS, EMR, etc.). 

Exporting using DICOM would be the best 

choice for providing a copy of a study to a 

patient or referring physician for instance.

Top
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The DICOM + Viewer option will also 

include a standalone DICOM Viewer 

application so that the study can be easily 

opened on another Windows computer.

Top
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Top

TIMS MVP provides a summary of the 

study so you have an idea of how much 

disk space the export will take up.

Click the folder icon to choose a 

destination for the exported study.
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The next option is “Folder Name Template” 

which pops up a list of naming conventions to 

choose from. TIMS MVP will create a new folder 

based on this template to export the study into.

Just like sending a study, you can export one or more individual 

series from the study by clicking the “Export Checked” box, then 

selecting each series you’d like to be included.

Click “OK” when you are ready to export.

Top
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Top

The backup option can be used to export a study from one TIMS MVP system and import it into 

another TIMS MVP or TIMS Review workstation. This format is proprietary to TIMS MVP and 

would not be compatible with other healthcare software systems.
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Once an Export is completed the study is locked for further edits. To continue editing unlock the study.
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You also have the option to Duplicate a study. Under the file menu choose “Duplicate…”. The software 

creates an exact duplicate of the study allowing it to be used as a separate study for research, teaching, 

training, presentations, or other applications. The study information can then be changed or anonymized. 

When you are ready, select “Duplicate” on the bottom right. 

Top
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Check the “Use Area of Interest” box to anonymize patient 

information before using it in a report or presentation. Adjust the 

crop area using the green “handles” provided.

Top

Patient Information
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To initiate an export from the Study List, “right click” on 

the study you want to export and choose “Export…”.

Top
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You can also export a group of studies from the study list. Select the first study, then hold down the 

“Shift” key to select the last study in a contiguous group.

If you hold down the “Ctrl” key instead of shift, you can select a non-contiguous group of studies.

Then “right click” on any selected study and choose “Export…” from the menu. 

The “Export Setup” dialog will show the list of studies on the right instead of the individual series. 

Click “OK” to export them all to the selected destination.

Top
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TIMS MVP can export your study as an MP4 video, which 

could then be imported into a presentation, or any 

application that supports the MP4 movie format.

You can optionally include the labels as “title screens” that 

appear before each swallow.

If the patient's name, or any other PHI, appears in the video 

itself, you can remove it using the “Area of Interest” tool.

To get started: open a study and choose “Export as 

Video…” from the File menu.

You could also “right click” on any series and choose 

“Export Series as a Video” to export just that series.

Top
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Choose a destination as 

shown in the previous 

Export section.

Choose whether to include 

the recorded audio.

Optionally generate title 

screens using series labels, 

and it’s duration.

Either create one video for 

the entire study, or a video 

for each series.

Select a naming convention.
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You may then use the Triple Bar icon to rearrange 

the order you want them to appear in the video.

If you wish to include only specific series from the study to 

export, select the “Export Checked” option and click the arrow

 to move the series you would like to include. You can “scrub” on 

the thumbnails with your mouse to review the video!



V1.3

If your fluoroscope embeds 

PHI in the video, use the 

“Area of Interest” tool to crop 

it out.

Once checked, a green box 

will appear over the video. 

Use the square “handles” at 

each corner to size the box 

so the PHI is cropped.

Top

Select “Create a Patient info 

File” to include a TXT file of 

the patient info. This may be 

needed when importing 

studies into some VNAs.

Click “OK” to start the export.
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When the export is complete you will see a pop-up menu and 

have an opportunity to open the folder.
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If you would like to save a single image, first scrub to the 

desired image, then select “Export Image” from the file menu.

The “Export Image” function is also available by 

“right clicking” with your mouse. 
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Patient Information

Click OK to save the image as it is.

Or check the “Use Area of Interest” box, which is useful if 

you’d like to anonymize an image with patient information 

before using it in a report or presentation. Adjust the crop 

area using the green “handles” provided.

Top
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Patient Information

Top

A dialog box will appear allowing you to navigate to a destination 

for the saved image. Click “Export” to save the image.
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Import Media Files

Top
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Top

From the File menu select Import Media Files to import 

JPG files or MP4 files into your studies.

Top
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Top

Select one or more files 

and click Import.

Top
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PatientView

Top
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PatientView, for recording an inset of the 

view of the patient with the MBS or FEES 

video, is a new feature of 5.0.  If you are 

interested in configuring this option, contact:

Support Hotline: 978-458-4624 x204

We have staff available to assist you

 Monday through Friday 8am to 8pm EST.

Top
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Top

Compare Studies

Side-by-Side
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Top

You can compare side-by-side studies that have the same patient ID number.
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Top

First open a study that you would like to compare.
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If a comparison study is available, the COMPARE option 

will be active. Click COMPARE to get started.
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Top

The drop down shows dates of studies 

performed with same patient ID.
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Top

Play and pause either study.
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The series number and any applied labels are shown 

to help select series with matching consistencies.
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Top

“Scrub” through the recorded video on ether series by holding down 

the left mouse button and moving up & down or right & left.
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Top

Use the arrows on ether side to quickly 

navigate between individual series.
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Top

Double click on either image to zoom in. Grab the image 

with the mouse or use the sliders to view a specific area.
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FEES Workflow 

Top
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When recording a FEES study with TIMS MVP there are 

several options for entering patient information.

Choose the option that matches your situation.

Perform studies using basic patient 

information, then import the remaining 

Worklist data afterwards.

Learn how to do that here.

Create studies in advance using the 

worklist, and record into them as they are 

performed.

Learn how to do that here.

A FEES Worklist is available, and you 

perform the studies in a room with access 

to the hospital network. Use the same 

workflow as MBSS.

Learn how to do that here.

Workflow 1

Your hospital does not provide a Worklist 

for FEES studies at all. Manually enter the 

required data.

Learn how to do that here.

Workflow 3Workflow 2

A FEES Worklist is available, but you 

perform the studies bedside or in rooms 

without network access.

Follow the links to learn more about a specific workflow, then 

return here to continue with other FEES study options.
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The “Study Info” screen allows you to 

enter the required study information. 

You MUST complete at least the fields 

for First Name, Last Name, Date Of 

Birth, and Patient ID. 

 If you are sending the completed 

studies to PACS, your PACS 

administrator can tell you what 

additional information may be required.

Top
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If your TIMS MVP System is on a mobile cart, and 

used in more than one procedure room, be sure 

the correct modality or room designation is 

selected in the “Channel” setting. The “Keywords” field is for your reference only. This 

information is not sent to PACS. It is a handy way to 

quickly find completed studies later in the Study 

Dashboard. Once you enter a keyword, it will 

autocomplete the next time you start typing it.

Once everything looks complete, click “OK” to proceed.

Top
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TIMS MVP will next open into the “LIVE” tab. Click here anytime 

during a study to see the live video from the FEES scope. TIMS 

MVP is now ready to start recording.

Top
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You can start and stop recording by:

• Clicking the start / stop record button (highlighted below)

• Tapping spacebar on the keyboard 

• Pressing a button on the FEES scope (if supported) 

• Utilizing an external foot pedal.

Top
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Typical FEES recording options:

• Record one continuous video (it can be edited later)

• Record a few video files of several minutes each

• Start and stop to capture just what you need as you go

Top

Open and close the panel for 

thumbnail views for each 

recorded series and maximize the 

viewing space for the Live video
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You can take a single frame “snapshot” of the current live image.

Use the Camera button OR press the F12 key. 

The option for snapshots can be used at any time while recording. The snapshots 

will be displayed after the full video on the left and marked with the Camera icon.

Top
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Single click on a thumbnail at any time to review it. The green 

line indicates that you are now in the SERIES tab. Select the 

LIVE tab at any time to return to the live video. 

Top
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There are several ways to play though the video image:

• Hold-down the left mouse button and “scrub” up & down or right & left.

• Use the Play / Pause button or the “play head” control. (highlighted below)

• Use the space bar to start and stop the playback.

• Use the mouse wheel or keyboard’s arrow keys for frame-by-frame precision.

Top
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You can extract a single frame “snapshot” of the current 

image. Use the Camera button OR press the F12 key.

Click here to learn how to add visual annotations to the 

snapshot.

Top
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A new feature of TIMS MVP 5.0 is "Swallow Detect”,

it shows on the timeline where the swallows appear. 

Right click on any Series and select Detect Swallows to 

enable this feature when desired. It can also be 

permanently added to the channel so its always on.

If you are interested in configuring this option contact:

Support Hotline: 978-458-4624 x204

We have staff available to assist you

 Monday through Friday 8am to 8pm EST. 

Top
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A pop up will give you the option to add an associated label,  It will list the 

series number that the clip was extracted from, and where the sub clip ended. 

You can accept or revise it to suit your preference. Click “OK” to accept.

That information appears as 

a new Series at the top just 

below the full recording.

Top

There are two ways to extract Subclips from a longer video:

Method 1

Right click on the timeline (bottom) at the point where you want to start the Subclip.

Drag to the point where you want to end the Subclip, then click the Subclip icon (right).
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Method 2

Drag the trimming markers on either side of the timeline to set the start and 

end points. As you drag the markers the video will scrub along with you. 

Click the Subclip icon to extract it.

Top
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Top

A pop up will give you the option to add an associated label,  It will list the 

series number that the clip was extracted from, and where the sub clip ended. 

You can accept or revise it to suit your preference. Click “OK” to accept.



V1.3

Top

Click the down arrow to access existing labels.
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A pop up will give you the option to add an associated label,  It will list the 

series number that the clip was extracted from, and where the sub clip ended. 

You can accept or revise it to suit your preference. Click “OK” to accept.

That information appears as 

a new Series at the top just 

below the full recording.

The new Subclip will be added to the study. Note the Video 

Camera icon indicating it is a Subclip. The Subclip is 

automatically flagged to be sent.

The duration of the Subclip is shown on the left. 

Top
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“Create Composite Clip” allows you to combine multiple 

series into one large single clip. 

Top
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Add or remove any series you want to combine 

using the arrows. By default, all Subclips are 

selected automatically to save you time!

Top
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Drag the Triple Bar to rearrange the order for the 

images included in the Composite Clip.

Top
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Select OK to combine those individual series. 

Top

Create the label you want for the new Composite Clip, 

and it will automatically label it for you. 
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The new Composite Clip is added the end of the study. It will be 

marked with the Composite Clip icon and marked with a label if 

one was added. The other original series remain intact.
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Another option is to replace the smaller individual series 

with the newly created Composite Clip. This Composite Clip 

would take the place of the previous recordings.
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Here is the new Composite Clip. It replaces the original Subclips.

It's marked with the Composite Clip icon as well as the label that was created for it. 
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The ”Saturation” control can be used with FEES 

studies to help make a dyed bolus more visible. 

Single click the control to reset it to the default.

Top
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When the study is complete you can archive it 

to your PACS/VNA or send it to a TIMS Review 

workstation for further analysis and reporting. 

Learn more about all the sending options here.

Top
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If “Send Checked” is selected, 

you can select or deselect any 

specific views to send.

Click the SEND button to 

send the study.

Top
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Once you decide to send the study it will 

be locked from further editing or 

recording. The study can be manually 

unlocked later if necessary.

Top
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When recording FEES, or other endoscopic procedures that can require longer 

format recording, TIMS MVP can be configured to save studies using the MP4 

file format. MP4 is a modern video file format which results in significantly 

smaller files vs the JPEG format used for MBSS fluoroscopy procedures.

Note: Not all PACS systems will accept the MP4 format. MP4 files can typically 

be archived to a VNA. A network storage location, or removable media such as 

USB or external hard disks, is an alternate strategy.
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Top

Note: If your PACS does not support MP4 files TIMS MVP can convert 

the files to JPG during the send process.

To configure this option please contact our technical support team!

TIMS Medical Technical Support

Call: (978) 458-4624 x204 (Mon-Fri 8am-8pm EST)
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Reporting and Notes  

are available with 

TIMS MVP 5.0.  

Register for training 

 with the link below.

Register Here

Or send an email to 

training@tims.com.

https://www.gotostage.com/channel/bd0686c0c0b94259929529d468254636
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Study List Maintenance

Top
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Patient Information

Once you have selected a group of studies to delete, “right 

click” on any of them and choose “Delete”.

Or you can choose the same using ”Edit” on the menu bar.

Top

Over time, you will want to delete studies from your TIMS MVP system to ensure 

there is always room for the new studies being recorded. You can check how 

much free space is available here.

TIMS MVP is not designed for long-term archival. Studies should be sent to 

either PACS / VNA or saved to another location on your network.
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You will be prompted to confirm the deletion. TIMS MVP 

will also provide a notification if you are about to delete a 

study that has not been archived elsewhere.

Click “Confirm” and then “Delete” to complete the process.

Top
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Creating and Editing Label Sets

Top
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TIMS MVP ships with the built-in label sets “Defaults” and “MBSImP”. These can be 

duplicated as the basis for a new label set, but not edited or deleted.
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To create your own Label Set start by choosing “New…” from the Label Set menu.

You can access this menu while you have a study open, or just click “Cancel” from 

the “Study Dashboard” to access the menu from the TIMS MVP main screen.
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The Label Editor will appear. Name your label set 

and use the “Tab” key to add the first label, then use 

“Tab” to accept that label and jump to the next one.

Top
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You can reorder your list at any time by 

grabbing the Triple Bar to move the label up 

and down the list to a new position.

Clear information using the ”x” button, 

Add a new label with the “+” button.

Delete using the “-” button.

Click “OK” when you are done.

Top
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Any Label Sets you have created can be deleted with the “Trash” icon, 

edited with the “Pencil” icon, or duplicated with the “Duplicate” icon.

You’ll notice that the new labels you just added will be included in the 

“autocomplete” database when you create or edit a list.

Top
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Measurement

Top
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To access the Measurement toolset, first open the 

Annotation tools, then toggle the slide ruler in the upper 

right corner to show an active green indicator.

Top
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Here you can change the color and line 

thickness for annotations or measurements.

Top
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To start lets look at some examples of linear 

measurement with the different tools..

Top

Let's look at the linear measurement tools first.



V1.3

To start lets look at some examples of linear 

measurement with the different tools..

Top

The line tool will draw a straight line with its 

length represented as number of pixels. This 

value is recorded in the upper right corner.
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To start lets look at some examples of linear 

measurement with the different tools..You can label each measurement using the field in the top right. 

The labels are then displayed with the measurement.

Top
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The Freehand tool can be useful for measuring irregularly shaped objects. 

Top
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To hide one or more of the image overlays, click on the Eye symbol.
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If you set the first measured value to 100, subsequently 

drawn lines are represented as a percentage of the first one.

Here the smaller line is 31.03% of the longer line. 
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To start lets look at some examples of linear 

measurement with the different tools..

Now let's look at the tools that measure area.

Top
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To start lets look at some examples of linear 

measurement with the different tools..

The Circle tool can be used to determine the area 

(in pixels) of regularly shaped round objects.

Top
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To start lets look at some examples of linear 

measurement with the different tools..

The Freehand tool can be used to determine the area of irregularly 

shaped objects by tracing the border and ending where you started.

Top
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To start lets look at some examples of linear 

measurement with the different tools..

The Magic Wand and Magic Brush tools are designed to 

quickly define an area for measurement.

Top
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The Magic Wand can be useful to estimate the area of 

distinct objects in the imagery, such as a bolus.

Top
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Click and drag out from the center of an object to expand the 

selection tolerance. Drag back to reduce the tolerance.

The resulting area is displayed in number of pixels.

Top
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The Magic Brush is used by “nudging” the selection 

towards the edges of an object.

Top
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Keep the brush within the shape and close to the edge, 

but not beyond it, to define an area. 

Top
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An Arrow annotation can be used to create a callout with a label.

Top
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A single frame snapshot can be used to add the annotated image into the 

study. All snapshots are marked with the Camera icon. These snapshots 

can be included with the study when archiving to PACS or VNA.



V1.3

Select the Eraser tool from the Annotation toolset to erase a 

specific measurement or annotation.

Top
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Hover over the annotation or measurement to erase it.

In this example the arrow annotation was removed.

Top
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The last edit can be undone with the Undo button.

Top
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Clicking the Trashcan will clear away ALL values.

Top
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Measurement Example 

Hyoid Excursion
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In this example a penny was secured to the patient using medical tape.

By drawing a line, edge to edge through the center, the known diameter of 

the penny can be used to calibrate subsequent linear measurements.

Top
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A new tool in 5.0 allows you to easily calculate the largest width from a circle.

 To start, draw a circle using one of the magic brushes to outline the circumference. 

Next select “Find Largest Width” icon in the upper right-hand corner.
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This tool will draw your line creating an exact diameter.

Replace the pixel value with your calibration value.

In this example the pixel value is changed to 19.05, the 

known diameter of a penny in millimeters. 
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To approximate excursion, start a line from a 

specific point on the Hyoid at rest. In this 

example we used the bottom left corner.

Top
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Moving frame-by-frame, find the frame with the Hyoid at 

maximum excursion. Using the Move tool, extend the 

measurement to the same reference point on the Hyoid. The 

excursion value will be displayed in millimeters.

Top
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By expanding the excursion value, you will reveal the 

Superior and Anterior movement values. TIMS MVP 

calculates these automatically for you.
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By selecting “Copy Measurements” from the Edit menu, you can then 

paste a table of your results into a report, in this case Microsoft Word.
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Measurement Example 

Estimating Residue
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First, we need to define the area of the entire bolus. Find a frame that allows you 

to most easily outline it with either the Magic Brush or Magic Wand tool.

Top
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Change the measured value to 100 in order to represent it as a percentage. 
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Hiding the initial bolus measurement may make it 

easier to outline the residue.  
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Move forward through the swallow until you can see residue.

The view can be zoomed in to trace more accurately.
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Using the Magic Wand and or Magic Brush tool, outline the area of the residual amount. 

The measured value is represented as a percentage of the entire bolus.
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You can add your measured values as a table to a report by copying information 

using the Edit menu (be sure the values are not hidden).

Deleted or erased values will not be included.
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Scoring a Study

Top
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Before implementing any of the included scoring protocols in TIMS MVP it is 

recommended that you consult the following resources that have been 

suggested by the researchers that developed them:

MBSImP

For MBSImP information & training the most direct link is:

https://www.northernspeech.com/MBSImP/ 

Other relevant articles, papers and validation studies:

- Martin-Harris, B., Brodsky, M. B., Michel, Y., Castell, D. O., Schleicher, M., Sandidge, J., ... & Blair, J. (2008). 

MBS measurement tool for swallow impairment—MBSImp: establishing a standard. Dysphagia, 23(4), 392-

405.

- Martin-Harris, B., Humphries, K., & Garand, K. L. (2017). The modified barium swallow impairment profile 
(MBSImP™©)–innovation, dissemination and implementation. Perspectives of the ASHA Special Interest 

Groups, 2(13), 129-138.

- Clain, A., Alkhuwaiter, M., Davidson, K., Martin-Harris, B. (2022, online ahead of print). Structural Validity, 

Internal Consistency, and Rater Reliability of the Modified Barium Swallow Impairment Profile: Breaking 

Ground on a 52,726-Patient Clinical Data Set. Journal of Speech, Language, and Hearing Research, 65(3), 1-

12.

DIGEST

DIGEST training is recommended and available at: https://mdanderson.cloud-cme.com/digest

Join the mailing list: DIGEST@mdanderson.org

Here are some suggested papers on FOIS & PAS:

FOIS: Crary, M. A., Mann, G. D. C., & Groher, M. E. (2005). Initial psychometric assessment of a functional oral intake scale 
for dysphagia in stroke patients. Archives of physical medicine and rehabilitation, 86(8), 1516-1520.

PAS: Rosenbek, J. C., Robbins, J. A., Roecker, E. B., Coyle, J. L., & Wood, J. L. (1996). A penetration-aspiration scale. 
Dysphagia, 11(2), 93-98.

https://www.northernspeech.com/MBSImP/
https://urldefense.com/v3/__https:/mdanderson.cloud-cme.com/digest__;!!PfbeBCCAmug!1Mn1KscaMsffusRRCnVd0jAn7TjmwjEYt6seaFjtpTm_cpixZxgu7wUSLTNxvF2e8A$
mailto:DIGEST@mdanderson.org
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Click on the Score button on to begin scoring a study.  

Top
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Use the Scorecards dropdown to view and select available scorecards. 



V1.3

Use the Scorecards dropdown menu to select a scorecard from the list. Several standardized 

protocols are included with TIMS MVP, but you can create your own if you like.

Select the scorecard protocol(s) you want to use. Multiple cards can be selected. 

     Uncheck a scorecard to remove it from the study. 

Selected scorecards become the default for each newly created study.

Top
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Choose the scorecard you want to work with first. Use the on-screen arrows 

to scroll through the available scorecards or review the results.

Top
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Enter the appropriate score for each component 

while reviewing the swallow video.

Top
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You can type a number directly into the field, or 

increment up and down with the arrows.

Top
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Clicking on the pop-up menu will reveal a list of choices 

with hint text to remind you what each score represents.

Select a choice from the menu to enter it!
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Hover over a selection with your mouse and 

additional information may be presented regarding 

that particular component. 

Top
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A single click in the scoring field will quickly produce the first value in the list.

Top
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Scoreboard lights give a quick visual representation of the results with 

green indicating more normal scores and red indicating an issue.

Top
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The results are calculated using the entered scores for each section.

Top
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Copy and paste the info into a document or report.
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TIMS Connect

Top
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What is TIMS Connect?

Top

TIMS Connect makes it possible to live-stream an MBS or FEES study from a 

procedure room to another computer in the hospital running TIMS Review.

The point-to-point connection facilitates collaboration and communication 

throughout a hospital, or hospital group, in real time.

Live Stream fluoro or FEES video from TIMS MVP!

Two-way webcam video and audio!

Speech Office or any computer

running TIMS ReviewTIMS MVP in radiology or any 

procedure room
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What is TIMS Connect?

Top

TIMS Connect Features

• Software add-on for any TIMS MVP system

• Real time video transmission from any modality (fluoroscopes, endoscopes, ultrasound etc.)

• Optionally control the in-room system remotely to record, edit & review studies!

• Two-way live webcam video & audio

• Utilizes existing hospital networks

• Remote user support with VPN

• Secure & encrypted

Typical Use Cases for TIMS Connect

• Quickly and easily consult with experts within the hospital system. 

• Train new staff without overcrowding procedure rooms.

• Efficiently supervise procedures remotely from any office. 

• Educate students in a university setting to prepare for live ”in-room” procedures.

TIMS Connect is a paid subscription add-on to TIMS MVP

You can receive a free trial for the TIMS Connect feature by calling our sales dept. at 

978-458-4624 ext. 298 or send an email to info@tims.com with your request. 

mailto:info@tims.com
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To initiate a TIMS Connect session from TIMS MVP

(in the procedure room) select Share from the Connect menu.

Top
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Select a 

camera source, 

microphone, 

and speakers.

Select SHARE to initiate the

TIMS Connect session.

Optionally allow the remote client to 

control the in-room system.

Top

The Host Name and PIN code.

A PIN is auto generated but you can 

add your own. It can optionally be 

reused in secure environments.

Preview of your webcam video.

The Share dialog is where you configure your video and audio 

settings and create a pin code for the Connect session.
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After clicking the Share button, a window confirms 

you are ready for a remote client to connect.

The Host Name and PIN are displayed for reference.

Top

The Host Name and PIN can be copied to share electronically.

A very efficient way to share your TIMS Connect session is to 

use the built-in QR code. Take a picture of the provided QR code 

and text it to a colleague. They can simply show the QR code to 

their webcam in order to successfully join. 
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New and previous TIMS Connect 

sessions will be displayed here.

The green dot indicates that this 

session is currently available. 

All the same settings 

options are presented 

for the remote user.

When you are 

ready select join

The remote user, running TIMS Review, 

selects “Join” from the Connect menu.
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Once joined, a movable webcam window will 

appear. Your colleague’s video always up 

top, with your video underneath.

The remote user’s TIMS Review screen will be replaced 

with the TIMS MVP screen from the procedure room. 

You’ll see the live fluoro video, and optionally be able to 

control the “in-room” system, just as if you were there!
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When in the smallest window view 

selecting the three dots brings up the 

controls for fit, swap, size and to mute.



V1.3

Top

Click on the Mic 

icon or select 

“MUTE” to mute 

your microphone. 

The webcam window can be re-

positioned wherever you like.

Clicking on the plus or minus 

icon will allow you to display or 

hide the web camera view.
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Click the “SIZE” icon to optimize the web camera screen. Here 

is an example of the largest of three different window sizes.

Top
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Select “FIT” to optimize the size of the TIMS MVP 

screen display for a larger viewing window. 



V1.3

Top

Select “ACTUAL to see the viewing frame as it 

appears on the TIMS.
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When you select “SWAP” the camera 

changes to show the In-room view in the 

larger window space. The TIMS MVP view is 

swapped to the smaller display window.

Top
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Select Control.

If remote control is enabled and granted, the 

“CONTROL” icon will be visible. If it is not 

available or shows a slash mark, it would need 

to be enabled from the TIMS MVP System first.
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From the TIMS MVP system, Click on the 

“CONTROL” icon with the slash mark to release 

control over TIMS MVP System remotely. 
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You can chat messages in the text box.

Once you have taken control of the 

TIMS MVP System you have the full 

control to be able to set up new studies, 

as well as the ability to Record, Edit, 

Review, and even Send! 
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When you are finished select LEAVE.
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There is a Pop up to notify that the session 

has ended. Select “OK” to close.
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Top
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TIMS Technical Support
 Call: (978) 458-4624 x204 (Mon-Fri 8am-8pm EST)
 Email: support@tims.com

TIMS Sales and Support Contract Renewal
 Call: (978) 458-4624 x200
 Email: sales@tims.com

Top

mailto:support@tims.com
mailto:sales@tims.com
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FEES Workflow 1

This workflow is identical to recording MBS studies in a fluoro room.

The basic steps are:

• Select a patient from the Worklist.

• Record the FEES procedure.

• Send the study to PACS or TIMS Review.

Continue for specific step-by-step instructions…

Return to FEES Workflow
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TIMS MVP should open directly to the Worklist tab in the Study Dashboard.

The Study Dashboard is the starting point for creating a new study.

Top
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Select your patient from the worklist.

Double click, press “Enter” on the keyboard, or 

click the “New…” button to proceed.

Top
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TIMS MVP should open directly to the Worklist tab in the Study Dashboard.

The Study Dashboard is the starting point for creating a new study, or 

opening an existing study from the Studies tab.

* If you aren’t using a Worklist, you can enter patient information manually 

using the “New Blank Study…” button.

You can quickly search on any 

column using the “filter list” option.

Top
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The filtering option is very powerful. You can 

search on virtually any column by typing just a few 

letters. Here the list has been narrowed by typing a 

few letters of the patient’s first name.

Top
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The list has been further narrowed by adding a space then 

a few letters of the referring doctor’s last name.

Top
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You may also filter by study date if you need to locate a patient 

from a previous or future date by clicking on the calendar icon.

Top
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You may also refresh the worklist by clicking this icon.

Top
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The “Study Info” screen provides you will the opportunity to 

confirm that all the study information is correct or make any 

necessary changes. These fields are all editable if required.

Top
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If your TIMS MVP System is on a mobile cart, and 

used in more than one procedure room, be sure 

the correct modality or room designation is 

selected in the “Channel” setting. The “Keywords” field is for your reference only. This 

information is not sent to PACS. It is a handy way to 

quickly find completed studies later in the Study 

Dashboard. Once you enter a keyword, it will 

autocomplete the next time you start typing it.

Top Return to FEES Workflow here.

Once everything looks complete, click “OK” to proceed.
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FEES Workflow 2a

This is one of two workflows used when you do have a FEES 

worklist, but not at the point-of-care.

Some of our customers follow this routine:

• At the start of the day create a series of “empty” studies using 

the worklist, one for each scheduled patient, while the TIMS 

System is connected to the hospital network.

• As you are about to perform a FEES study, open the 

appropriate pre-saved study and record into it.

• Send the completed studies to PACS or TIMS Review when 

the TIMS System is re-connected to the hospital network.

Continue for specific step-by-step instructions…

Return to FEES Workflow
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Select the Worklist tab from the Study Dashboard.

Top
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Select your patient from the worklist, then either “double click”, 

press “Enter” on the keyboard, or click  “OPEN…”

Top
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The “Study Info” screen provides you with the opportunity to 

confirm that all the study information is correct or make any 

necessary changes. These fields are all editable if required.
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Once everything looks complete, click “OK” to proceed.

The “Keywords” field is for your reference only. This 

information is not sent to PACS. It is a handy way to 

quickly find completed studies later in the Study 

Dashboard. Once you enter a keyword, it will 

autocomplete the next time you start typing it.

If your TIMS MVP System is on a mobile cart, and 

used in more than one procedure room, be sure 

the correct modality or room designation is 

selected in the “Channel” setting.
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Ignore any video you may see in 

the LIVE view at this point.

At this point simply close the study.

An empty study will be saved with the patient information.
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When you are ready to perform the study, select the Studies tab in the Study 

Dashboard and re-open the study you saved previously.
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TIMS MVP is now ready to start recording.

Return to FEES Workflow here.Top
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FEES Workflow 2b

This is the second of two workflows used when you do have a FEES 

worklist, but not at the point-of-care.

Some of our customers follow this routine:

• Create a new study, right before performing it, using the minimum 

required information: patient name, patient ID, DOB.

• Record and then close the study. It will be saved to the Study List.

• Later, when the TIMS System is connected to the hospital 

network, easily update additional study info from the worklist for 

each study saved in this way.

• Send the updated studies to PACS or TIMS Review.

Continue for specific step-by-step instructions…

Return to FEES Workflow
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In order to start a recording, you must fill out the required fields:

First Name, Last Name, Date Of Birth, and Patient ID.

Perform the study, then close it when complete. It will be saved automatically.

Use the “New Blank Study” option.
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When you have access to the hospital network, find the patient 

you want to update from the Worklist and open the study.
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Unlock the study so the patient info can be updated.

Then click ”Open” to access the Study Dashboard.
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Select the Worklist tab, then

right click on the correct patient and select 

“Update Study info Based On”.
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Verify the information is correct and select OK.

The study will now reflect the information from your Worklist.

Top Return to FEES Workflow here.
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Continue for specific step-by-step instructions…

FEES Workflow 3

This workflow is used when the hospital does not provide a FEES worklist.

The basic steps are:

• Create a “New Blank Study”.

• Manually enter all the patient data.

• Record the study.

• Send it to PACS or TIMS Review.

Return to FEES Workflow
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If your hospital does not have a Worklist for FEES 

you can use the “New Blank Study” option.
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In order to start a recording, you must fill out the required fields for: 

First Name, Last Name, Date Of Birth, and Patient ID. 
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If you are sending the completed studies to PACS, 

your PACS administrator can tell you what 

additional information may be required.
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Once everything looks complete, click “OK” to proceed.

Return to FEES Workflow here.

If your TIMS MVP System is on a mobile cart, and 

used in more than one procedure room, be sure 

the correct modality or room designation is 

selected in the “Channel” setting.

The “Keywords” field is for your reference only. This 

information is not sent to PACS. It is a handy way to 

quickly find completed studies later in the Study 

Dashboard. Once you enter a keyword, it will 

autocomplete the next time you start typing it.
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TIMS MVP TRAINING 

for

Endoscopic Procedures

TopTop
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Covered topics:

• Starting a study and querying the patient information

• Capturing individual still shots, or single frame images

• Capturing live motion video 

• Editing tools (graphic annotations & trimming)

• Adding labels 

• Send studies to PACS

• Study Start with No Worklist
Top



To launch the TIMS MVP application:
- Double click the icon on the desktop or
- Single click the icon on the task bar

Top



Top
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To start a study, find your patient and simply double click or 

select the patient with your mouse and click the NEW button.

Top
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Verify the information is correct and select OK.

Top
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To take single frame snap images:

• Use the button on the scope (typically #4 for triggering)

• Or use the camera icon

• Or the F12 key

Top
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From any view SEND is at the top 

Top
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To capture motion video:

• Press the spacebar to start/stop

• Use the record button to start/stop

Top
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To add labels:

• Use the dropdown menu

• Or type required text

Top
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Annotate using the tools on the right. 

Top
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Trim video using the arrows on the bottom 

of the green timeline.

Top
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Select the 

destination 

and click 

SEND.

Top
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With “Send Checked” selected, 

you can select individual images to 

send to PACS or VNA.

Top
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Study Start with No Worklist

• Create a new study using “New Blank Study” button.

• Enter the minimum required information:  patient name, patient ID, DOB.

• Record the study and then close the study.  It will be saved to the study list.

• Later, when a worklist entry is available, easily update the study by

     applying a worklist entry to the existing study.

• Send the updated study to PACS.

Top



V1.3

In order to start a recording, you must fill out the required fields:

First Name, Last Name, Date of Birth, and Patient ID.

Perform the study, then close it when complete. It will be saved automatically.

Use the “New Blank Study” option.

Top
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When you have access to the hospital network, find the patient 

you want to update from the Worklist and open the study.

Top
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Unlock the study so the patient info can be updated.

Then click ”Open” to access the Study Dashboard.

Top
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Select the Worklist tab, then

right click on the correct patient and select 

“Update Study info Based On”.

Top
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Verify the information is correct and select OK.

The study will now reflect the information from your Worklist.

Top


